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Safety Information

Do NOT ser vice or re pair this prod uct un less prop erly qual i fied. Ser vic -
ing should be per formed only by a qual i fied tech ni cian or an au tho rized
Au dio Pre ci sion distributor.

Do NOT de feat the safety ground con nec tion. This prod uct is de signed
to op er ate only from a 50/60 Hz AC power source (250 V rms max i mum)
with an ap proved three-con duc tor power cord and safety ground ing. Loss
of the pro tec tive ground ing con nec tion can re sult in elec tri cal shock haz ard 
from the ac ces si ble con duc tive surfaces of this product.

For con tin ued fire haz ard pro tec tion, fuses should be re placed ONLY
with the ex act value and type in di cated on the rear panel of the in stru ment 
and dis cussed on page  of this man ual. The AC volt age se lec tor also must
be set to the same volt age as the nom i nal power source volt age (100, 120, 
230, or 240 V rms) with the ap pro pri ate fuses. Dif fer ent fuses are re quired
de pend ing on the line voltage.

The In ter na tional Electrotechnical Com mis sion (IEC 1010-1) re quires
that mea sur ing cir cuit ter mi nals used for volt age or cur rent mea sure ment
be marked to in di cate their In stal la tion Cat e gory. The In stal la tion Cat e gory 
is de fined by IEC 664 and is based on the am pli tude of tran sient or im -
pulse volt age that can be ex pected from the AC power dis tri bu tion net -
work. This prod uct is clas si fied as INSTALLATION CATEGORY I,
ab bre vi ated “CAT I” on the instrument front panel.

Do NOT sub sti tute parts or make any mod i fi ca tions with out the writ ten
ap proval of Au dio Pre ci sion. Do ing so may cre ate safety hazards.

This prod uct is for in door use—pol lu tion de gree 2.
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Safety Symbols

The fol low ing sym bols may be marked on the pan els or cov ers of equip -
ment or mod ules, and are used in this man ual:

WARNING!—This sym bol alerts you to a po ten tially haz ard ous con di -
tion, such as the pres ence of dan ger ous volt age that could pose a risk of
elec tri cal shock. Re fer to the ac com pa ny ing warn ing la bel or tag, and ex er -
cise extreme caution.

ATTENTION!—This sym bol alerts you to im por tant op er at ing con sid er -
ations or a po ten tial op er at ing con di tion that could dam age equip ment. If
you see this marked on equip ment, re fer to the Op er a tor’s Man ual or
User’s Man ual for pre cau tion ary instructions.

FUNCTIONAL EARTH TERMINAL—A ter mi nal marked with this sym -
bol is elec tri cally con nected to a ref er ence point of a mea sur ing cir cuit or
out put and is in tended to be earthed for any func tional pur pose other than 
safety.

PROTECTIVE EARTH TERMINAL—A ter mi nal marked with this sym -
bol is bonded to con duc tive parts of the in stru ment and is in tended to be
con nected to an ex ter nal pro tec tive earthing system.

Disclaimer

Au dio Pre ci sion cau tions against us ing their prod ucts in a man ner not
spec i fied by the man u fac turer. To do oth er wise may void any war ran ties,
dam age equip ment, or pose a safety risk to personnel.
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Chapter 1
General Information

ATS-2: An Overview

The Au dio Pre ci sion ATS-2 is a pow er ful com puter-con trolled au dio test 
and mea sure ment sys tem con sist ing of two key components:

§ The ATS-2 hardware: the connectors and circuitry necessary for
precise signal generation and analysis, and for interfacing to devices.
The hardware is mounted in a compact (2 U) aluminum and steel
chassis that can be installed in a standard equipment rack using
optional mounting hardware.

§ The ATS measurement software, which runs on a personal computer
(PC), and provides the control, display, report and automation
functions for the ATS-2 system. The ATS software will run under
Microsoft Windows XP, Windows Vista and Windows 7.

With the ex cep tion of the mains power switch on the rear panel, there
are no knobs, di als, con trols, read outs, me ters or switches on the ATS-2
chas sis. All of these func tions are per formed via the ATS soft ware on the
con trol ling PC.

Getting Started with ATS-2 1
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APIB

The ATS con trol soft ware on the PC com mu ni cates with the ATS-2
hard ware in one of two ways:

§ USB-APIB
Introduced with the release of ATS version 1.6, the USB-APIB
adapter provides a convenient USB interface to the instrument. USB
operation is not supported by earlier versions of ATS.

§ APIB
APIB (Audio Precision Interface Bus) is a proprietary bus
interconnection that requires a dedicated APIB cable and
PC-mounted APIB interface card or adapter. APIB interfaces are
available as PCI, PCI Express  or PCMCIA-compatible devices.

The USB-APIB adapter or APIB in ter face are spec i fied at the time your
sys tem is or dered. An in ter face adapter kit can also be or dered sep a rately.

GPIB

When or dered in the op tional GPIB con fig u ra tion (ATS2G), ATS-2 can
also be con trolled by the in dus try-stan dard IEEE 488.2 Gen eral Pur pose
In ter face Bus (GPIB). See Chap ter 7 for more in for ma tion about the
ATS-2 GPIB configuration.

ATS-2 Capabilities

§ ATS-2 can make amplitude, frequency, THD+N, noise, phase,
crosstalk, bandpass, and IMD measurements for analog or digital
audio devices. In a special function, ATS-2 can perform detailed
analysis and measurement of harmonic distortion products.

§ ATS-2 can perform complex sweeps, and display and print the results 
with a powerful graphing engine. ATS-2 offers control over
instrument regulation and settling parameters. Data obtained from
sweeps can be compared to pre-defined limits. A variety of
computations can be performed on the measured data after
acquisition. Tests and data can be saved and recalled, and ATS-2
measurements can be automated by macros written in the AP Basic
programming language.

§ ATS-2 can perform measurements using fast Fourier transform (FFT)
analysis. Advanced high-speed FFT analysis techniques are available, 
including multitone recognition and analysis, frequency adjustment
for bin centering, synchronous FFT processing, and advanced
post-FFT analysis.

Chapter 1: General Information ATS-2 Capabilities
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§ ATS-2 can examine an AES/EBU digital interface signal and assure
the integrity of digitally transmitted data. It can also measure and
examine the jitter in the waveform. ATS-2 can extract a variety of
statistics from a digital waveform, including the sample rate, the
interface waveform voltage, the jitter amplitude, and the active and
inactive data bits. ATS-2 also has the capability of transmitting and
receiving a full complement of AES/EBU status bits.

§ ATS-2’s sample rate may be synchronized to an external AES/EBU
signal, a square wave, or an NTSC or PAL video source.

§ ATS-2 has two auxiliary control connectors for control of external
equipment.

Conceptual Architecture of ATS-2

The func tional com po nents im ple mented in ATS-2 in clude two au dio
sig nal gen er a tors, an au dio sig nal an a lyzer, dig i tal and an a log in put and
out put mod ules, and a mod ule for ex ter nal timebase synchronization.

All sig nal gen er a tion is per formed in the dig i tal do main. One of the two
sig nal gen er a tors is ded i cated to the dig i tal out put. The sig nal from this
dig i tal gen er a tor is buf fered and con di tioned for the bal anced, un bal anced
and op ti cal out puts. The out put of the sec ond sig nal gen er a tor is con -
verted to an an a log sig nal by a dig i tal-to-an a log con verter (DAC). The
two-chan nel out put of the DAC is con di tioned and ranged for the
balanced and unbalanced analog outputs.

All sig nal anal y sis is also per formed in the dig i tal do main. The dig i tal in -
put is buf fered and di rectly ap plied to the an a lyzer. An a log in puts are first
ranged and con di tioned, and then dig i tized by a high-res o lu tion an a -
log-to-dig i tal con verter (ADC) be fore be ing ap plied to the an a lyzer. An op -
tional high-band width ADC is avail able to increase measurement
bandwidth.

Conceptual Architecture of ATS-2 Chapter 1: General Information
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Analog Domain vs. Digital Domain

Analog audio signals are electrical analogies of the sound waves
that they represent, varying in frequency and amplitude in a continuous 
fashion. In analog audio electronics, these voltages and currents are
manipulated, processed, and measured by modifying their amplitude or 
frequency. The term analog domain refers to signals represented and
processed in this fashion.

Digital audio signals, on the other hand, are numerical
representations of the sound waves. The representation is often carried
on an electrical signal called the interface signal. Digital audio is
processed mathematically in processes gathered together under the
name of Digital Signal Processing, or DSP. The term digital domain
refers to signals represented and processed in this fashion.



About This Manual

You’re read ing Get ting Started with ATS-2. This man ual de scribes how
to set up the ATS-2 hard ware and ATS soft ware. It also con tains a quick
tu to rial to fa mil iar ize you with the sys tem. It is or ga nized as follows:

§ Chapter 2: Software installation and hardware setup information.

§ Chapter 3: Description of the hardware and its connectors.

§ Chapter 4: Description of the user interface.

§ Chapter 5: Introductory tutorial.

§ Chapter 6: Specifications.

§ Chapter 7: GPIB Configuration.

Online Help

Much of the in for ma tion con tained in the ATS-2 User’s Man ual is also
avail able in the on line help sys tem in cluded in the ATS soft ware. You can
ac cess the help sys tem in two ways:

§ ATS has context-sensitive help. Almost every control and display on
each software panel has a help topic associated with it. To view the
topic, click on the field or control, then press the F1 function key.

§ On the Menu bar, click Help. The Help menu offers commands to
search the Help Index, browse through the Help Topics, or select
a specific help library such as AP Basic Language.

Other Documentation for ATS-2

Au dio Pre ci sion pub lishes a va ri ety of doc u ments, many in elec tronic
form, about hard ware and soft ware prod ucts, au dio the ory, and test and
mea sure ment tech niques. The fol low ing list de scribes the doc u ments that
are in cluded as Adobe Ac ro bat Por ta ble Doc u ment For mat (PDF) files on
the Au dio Pre ci sion Re sources Disc. They can also be down loaded from
our Web site at ap.com.

ATS-2 User’s Manual

The ATS-2 User’s Man ual is the pri mary op er a tion and ref er ence man -
ual for the sys tem. Con sult the ATS-2 User’s Man ual for:

§ Detailed descriptions of every ATS-2 feature, software panel, control,
and display.

§ Reference information on audio test and measurement techniques,
sample and utility file listings, and an audio glossary.

Chapter 1: General Information About This Manual
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AP Basic User’s Guide and Language Reference

You can cre ate tests and mac ros to au to mate your mea sure ments. Mac -
ros are writ ten in the AP Ba sic pro gram ming lan guage, which is a sub set of 
Microsoft® Vi sual Ba sic®. The AP Ba sic User’s Guide and Lan guage Ref -
er ence, avail able as a PDF on the Au dio Pre ci sion Re sources disc, con tains 
a list of the AP Ba sic com mands, each with a full de scrip tion and ex am ples 
of us age.

AP Basic Extensions Reference for ATS-2

The AP Ba sic Ex ten sions Ref er ence for ATS-2, avail able as a PDF on
the Au dio Pre ci sion Re sources disc, con tains a list of OLE/ActiveX au to ma -
tion com mands that con trol the spe cific fea tures of the ATS-2 hard ware
and the ATS software.

Other Publications

Au dio Pre ci sion pub lishes ap pli ca tion notes, tech notes, tech ni cal pa pers 
and train ing ma te ri als that cover all as pects of au dio test and mea sure -
ment. In for ma tion about our li brary of tech ni cal pa pers and an nounce -
ments of new pa pers is avail able from Au dio Pre ci sion Tech ni cal Sup port,
and on the Audio Precision Web site.

GPIB Documentation for ATS-2

When or dered in the op tional GPIB con fig u ra tion, ATS-2 can also be
con trolled by the in dus try-stan dard Gen eral Pur pose In ter face Bus (GPIB).

Ba sic in stal la tion with GPIB is cov ered in Chap ter 7 of this man ual. For
GPIB de vel op ment and pro gram ming, or der the ATS-2 GPIB Pro gram -
mer’s Ref er ence Man ual, which in cludes a CD-ROM with GPIB sam ple
program files.

Other Documentation for ATS-2 Chapter 1: General Information
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Chapter 2
Installation and Setup for APIB

ATS-2 Components

The fol low ing items are in cluded with a stan dard, APIB-con fig ured
ATS-2. For a GPIB-con fig ured ATS-2, re fer to Chap ter 7.

§ The ATS-2 hardware chassis.

§ A mains power cord.

§ A box containing the ATS-2 WIN-KIT interface kit.

The fol low ing items are con tained within the ATS-2 WIN-KIT:

§ This manual, Getting Started with ATS-2.

§ The ATS-2 User’s Manual. 

§ An Audio Precision Interface Bus (APIB) USB adapter or interface
card, as ordered.

§ The ATS control software CD-ROM, containing ATS control software
for the ATS-2.

§ An Audio Precision Resources Disc CD-ROM, containing sample files, 
user documents and other resources.

§ A playable audio compact disc AP-CD0, containing audio test
signals.

We rec om mend that you re tain the ship ping box and pack ing ma te ri als
to pro tect your in stru ment if you need to ship it in the future.

Getting Up and Running 

There are three main tasks to set ting up ATS-2:

§ Installing the ATS software on a personal computer (PC);

Getting Started with ATS-2 7



§ Configuring ATS-2 for the local mains power supply; and

§ Connecting the interface, using either the USB-APIB adapter or by
installing an APIB card in the PC.

These tasks are de scribed be low.

Installing ATS Software on a PC

PC System Requirements

Your ATS-2 in stru ment must be con nected to a Win dows-ca pa ble PC to
op er ate. The cur rent con trol soft ware is ATS ver sion 1.60, SP1 (Ser vice
Pack 1). SP1 has added 64-bit com pat i bil ity to ATS.

The PC must have the fol low ing op er at ing sys tem (OS), fea tures and ca -
pa bil i ties:

§ for operation using a 64-bit OS:
Windows 7 Professional SP1 64-bit.
Windows 7 Ultimate SP1 64-bit.

§ for operation using a 32-bit OS:
Windows 7 Professional SP1 32-bit.
Windows 7 Ultimate SP1 32-bit.
Windows Vista Business SP2 32-bit.
Windows Vista Ultimate SP2 32-bit.
Windows XP Professional SP3 32-bit.

NOTE: You must have local administrator rights to install ATS 

software. Go to User Accounts in the Windows Control Panel, 

or check with your network administrator.

§ You must have at least the minimum processor type and memory
required by Microsoft for the installed operating system.

§ You must have at least 300 MB of free hard disk space.

§ You must have CD-ROM drive.

§ for operation using a 64-bit OS:
You must have a USB 2.0 port, and use the Audio Precision
USB-APIB adapter.

§ for operation using a 32-bit OS:
You must have a USB 2.0 port for a USB-APIB adapter, or an open
PCI, PCI Express or PCMCIA slot to mount the APIB interface.

§ You must have a color monitor and a video card with at least VGA
capabilities. Video resolution of 1024 × 768 or greater is
recommended.

Chapter 2: Installation and Setup for APIB Installing ATS Software on a PC
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You will also need sig nal in ter face ca bles to con nect your ATS-2 in stru -
ment to your de vice un der test (DUT). Since there are many pos si ble con -
nec tion con fig u ra tions, sig nal ca bles are not pro vided with the in stru ment.
Au dio Pre ci sion of fers ca ble kits with com mon con nec tors and adapt ers for 
pur chase. Con tact a sales rep re sen ta tive or visit the Au dio Pre ci sion Web
site at ap.com for more information.

Installing the Software

To in stall the ATS soft ware, use the fol low ing pro ce dure:

§ Close all Windows programs.

§ Insert the ATS CD-ROM into the CD-ROM drive. The installation
program should start automatically. If it does not, click on the Start
menu and choose Run. Click Browse and choose the file Setup.exe
on the ATS CD-ROM. Click OK in the Run dialog box.

§ Follow the installer on-screen instructions.

Setting Up the ATS-2 Hardware

Connecting ATS-2 to the Electrical Mains Supply

ATS-2 must be con nected to a 50–60 Hz al ter nat ing cur rent (AC) elec -
tri cal mains sup ply, max i mum volt age 250 Vrms.

The units are con fig ured at the fac tory for the ex pected volt age at their
in tended des ti na tion. The volt age set ting and fus ing ar range ment will nor -
mally be cor rect un less the unit has been trans ported into an other area.

Setting Up the ATS-2 Hardware Chapter 2: Installation and Setup for APIB
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Figure 2. Detail, power entry module on ATS-2 rear panel.



The power en try mod ule has a strip of in di ca tor tape show ing its mains
volt age set ting. This tape must be removed before use.

You MUST be sure that the ATS-2 mains power configuration 

is correct for the electrical mains power supplied in your area. 

If you are not sure, do not plug ATS-2 in to the mains power.

Follow the instructions below to check or change the ATS-2

mains supply voltage selection.

The mains power sup ply is ap plied to ATS-2 through the power en try
mod ule lo cated on the rear panel. Be fore con nect ing the power cord, con -
firm that the in put volt age se lec tion and fus ing ar range ment in the power
en try mod ule are cor rect for your mains power supply.

Checking the Mains Supply Voltage Configuration

The volt age in di ca tor pin pro trudes through one of the four la beled
holes in the mod ule cover to in di cate the se lected in put volt age, as shown
in Fig ure 2. Check that the in di cated volt age matches your mains sup ply
voltage.

Opening the Power Entry Module

Un plug the power cord from the in stru ment be fore chang ing fuses or
per form ing any other op er a tions de scribed in this section.

To open the Power En try Mod ule, re fer to Fig ure 3 and pro ceed as fol -
lows:

Chapter 2: Installation and Setup for APIB Setting Up the ATS-2 Hardware
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Figure 3. Power entry module door and fuse block.



§ Remove the mains power supply cord from the power cord
connector.

§ Locate the slot in the module cover door hinge. The hinge is a the
left side of the cover door, and the slot in the hinge is visible in the
power cord connector cavity. Insert a small screwdriver or similar tool 
in the slot and pry the cover door hinge outward. The cover door will 
snap out, and then can be pivoted on its hinge for access to the fuse
block assembly and voltage selector card.

Changing the Mains Supply Voltage Configuration

§ Open the Power Entry Module as described above.

§ The voltage selector card is a small circuit board fitted with a white
plastic indicator pin, installed in a housing on the right side of the
Power Entry Module as shown in Figure 4. Pull the voltage selector
card straight out of the housing, using narrow pliers to grab the card.
Do not use the indicator pin as a handle.

§ Orient the selector card so that the desired input voltage is readable
at the bottom, shown in Figure 5. Then move the indicator pin to

Setting Up the ATS-2 Hardware Chapter 2: Installation and Setup for APIB
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Figure 4. Changing the mains power supply voltage.
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Figure 5. Voltage selector card positions.



point UP, opposite the indicated voltage. Seat the pin assembly in the 
notch on the board edge.

§ Insert the voltage selector card into the housing with the printed side
of the card facing toward the mains power connector. The card edge
indicating the desired voltage should enter the housing first.

§ Confirm that the correct fuse or fuse combination is installed for the
intended input voltage (refer to the fuse ratings marked on the
instrument rear panel). If necessary, change the fuse type as
described in the following section.

§ Close the module the cover door and verify that the indicator pin
shows the desired voltage.

Once you have ver i fied that the line volt age se lec tion is cor rect, con nect
the power cord from a mains power out let to the power cord con nec tor on 
the in stru ment rear panel.

Fuse Information

The power en try mod ule ac com mo dates two fus ing ar range ments, as il -
lus trated in Figure .

§ The North American fusing arrangement uses a single type 3AG
(0.25" × 1.25") SB (slow blow) fuse.

§ The European fusing arrangement uses two 5×20 mm IEC-approved 
type T fuses.

Re fer to the la bel on the rear panel for fuse cur rent rat ings.

Changing the Fusing Arrangement

To re place a fuse or change the fus ing ar range ment, pro ceed as fol lows:

§ Remove the mains power cord from the power cord connector and
open the Power Entry Module as described above.

§ Using narrow pliers, pull the fuse assembly out of the housing.
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§ Change or add the correct fuses as necessary, referring to Figure 6.
Refer to the instrument rear panel for the correct fuse electrical
current rating.

§ Insert the fuse assembly in the housing, with the side of the assembly
that carries the fuse(s) for your desired fusing arrangement facing into 
the housing. Press the fuse assembly firmly into the housing. 

§ Confirm that the line voltage selection is correct for your mains
voltage and your fusing arrangement.

Once you have ver i fied that the line volt age se lec tion is cor rect, con nect
the power cord from a mains power out let to the power cord con nec tor on 
the in stru ment rear panel.

Connecting ATS-2 to Your PC

The ATS con trol soft ware com mu ni cates with the ATS-2 in stru ment
through the Au dio Pre ci sion In ter face Bus (APIB). You will have re ceived
one of the fol low ing in ter face adapter op tions with your in stru ment, as or -
dered. The in struc tions be low as sume you have al ready in stalled the ATS
soft ware on your PC or laptop.

The USB-APIB adapter and cables

Con nect the USB ca ble from a USB 2.0 port on your PC or lap top to
the USB jack on the adapter. Con nect the APIB ca ble from the adapter to
your ATS-2. Turn on the in stru ment and the PC and launch ATS.

For best perfomance, we rec om mend that you con nect the USB-APIB
adapter di rectly to the PC USB 2.0 port, and that you do not use a USB
hub for this con nec tion.

USB 1.0 or 1.1 ports or hubs cannot be used.

Connecting ATS-2 to Your PC Chapter 2: Installation and Setup for APIB
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The APIB PCI Express card and cable

Turn off your PC and mount the PCI Ex press card in an open PCI Ex -
press slot. Con nect the PCI Ex press card to the in stru ment us ing an APIB
ca ble.

Note that PCI Express cards will not mount in standard PCI

slots, and that you may damage the card and your PC by

forcing an interface card into the wrong slot.

Turn on the PC and the in stru ment, and launch ATS.

The APIB PCI card and cable

Turn off your PC and mount the PCI card in an open PCI slot. Con nect
the PCI card to the in stru ment us ing an APIB ca ble.

Note that standard PCI cards will not mount in the newer PCI

Express slots, and that you may damage the card and your

PC by forcing an interface card into the wrong slot.

Turn on the PC and the in stru ment, and launch ATS.

Chapter 2: Installation and Setup for APIB Connecting ATS-2 to Your PC
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Figure 9.  PCI card and cable.



The APIB PCMCIA card and cable

Con nect the small con nec tor on the PCMCIA APIB ca ble to the match -
ing con nec tor on the PCMCIA card. Turn off your lap top and slide the
card into an open PC card slot. Con nect the other end of the APIB ca ble
to the in stru ment. Turn on you lap top and launch ATS.

Note: if your PC is fitted with more than one APIB interface

adapter,when ATS is launched Microsoft Windows will select

one to communicate with the software. An installed

USB-APIB adapter will have priority. 

Connecting ATS-2 to Your PC Chapter 2: Installation and Setup for APIB
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Chapter 3
Hardware Overview

The ATS-2 hard ware in cludes in put and out put con nec tors, rang ing and 
sig nal con di tion ing mod ules, dig i tal sig nal pro ces sors, mem ory, and other
cir cuitry needed to per form au dio mea sure ments. It is con nected to the
con trol ler PC by the Au dio Pre ci sion In ter face Bus (APIB). In this chap ter,
the fea tures of the hard ware are de scribed. For a full list of hard ware spec i -
fi ca tions, see Chap ter .

When or dered in the op tional GPIB con fig u ra tion (ATS2G), ATS-2 can
also be con trolled by the in dus try-stan dard IEEE 488.2 Gen eral Pur pose
In ter face Bus (GPIB). GPIB op er a tion is not cov ered in this chap ter. See
Chap ter 7 for more in for ma tion about the ATS-2 GPIB configuration.

All sig nal gen er a tion and anal y sis is per formed in the ATS-2 hard ware,
in clud ing stor age of sig nals ac quired for DSP wave form dis play or FFT
analysis.

ATS-2 Front Panel

The ATS-2 front panel, shown in Fig ure 11, in cludes the dig i tal and an -
a log in puts and out puts and a power in di ca tor.
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§ DIGITAL OUTPUTS
In single-connector mode, ATS-2 transmits stereo digital audio
simultaneously on the XLR “I” connector, the BNC connector, and
the optical connector. In dual-connector mode, channels A and B are 
transmitted on the XLR “I” and “II” connectors, respectively.

§ DIGITAL INPUTS
In single-connector mode, ATS-2 receives stereo digital audio from
the XLR “I” connector, the BNC connector, or the optical connector.
In dual-connector mode, channels A and B are received on the XLR

“I” and “II” connectors, respectively.

§ ANALOG OUTPUTS
The ATS-2 analog generator outputs (both “A” and “B” channels) are 
available as unbalanced signals on the BNC connectors and as
balanced signals on the XLR connectors.

§ ANALOG INPUTS
The XLR balanced and the BNC unbalanced connectors (both “A”
and “B” channels) are connected to the ATS-2 analyzer inputs.

See Chap ter 4 of the ATS-2 User’s Man ual for more in for ma tion about
the ATS-2 in puts and out puts and the pan els as so ci ated with them.

ATS-2 Rear Panel

The ATS-2 in ter face, mon i tor, head phone, trig ger, sync, and util ity con -
nec tions are mounted on the rear panel.

§ POWER ENTRY MODULE—this module includes:

� POWER SWITCH—This switch turns the mains power supply to
the ATS-2 hardware ON ( I ) or OFF ( O ).

Chapter 3: Hardware Overview ATS-2 Rear Panel
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� POWER CORD CONNECTOR—This is a standard grounded
connector for the mains power supply cord.

� FUSE HOLDER/MAINS SUPPLY VOLTAGE JUMPER—Contains
the mains power fuse and the mains supply voltage configuration
jumper card. See Chapter 2.

� MAINS SUPPLY VOLTAGE INDICATOR—The white tip of the
plastic indicator on the voltage configuration jumper card appears
in one of four small holes to show the mains voltage selection.

§ FUSE REPLACEMENT INFORMATION—This chart lists the fuse
values required for correct operation at the four supply voltage
options.

§ SERIAL NUMBER/OPTIONS LABEL—The Audio Precision serial
number for this ATS-2 chassis, and the hardware options (if any)
included in the chassis.

§ MONITOR JACK—This is a 3.5 mm jack suitable for driving stereo
headphones or other audio monitors.

§ RESERVED FOR GPIB PANEL—This blank panel can be removed
for factory installation of the GPIB configuration option, adding
GPIB (IEEE-488.2 General Purpose Interface Bus) functionality to
ATS-2. If your ATS-2 is configured for GPIB, see Chapter 7.

§ SYNC/REF IN—This connector provides an input for an external
digital audio signal, a square wave, or an NTSC/PAL video signal for
sample rate synchronization (“house sync”).

§ AUDIO MONITORS—The “source” connectors monitor the signal
currently being analyzed. The “function” connectors monitor the
function meter in the audio analyzer. These signals can also be
monitored on the internal speaker.

§ TRIG IN—This connector provides an input to trigger or initiate
certain measurement functions.

§ TRIG OUT—This connector provides an output for triggering an
external oscilloscope or other equipment.

§ APIB INTERFACE—This connector provides the two-way Audio
Precision Interface Bus connection between ATS-2 and the personal
computer running the ATS software.

§ AUXILIARY CONTROL OUT—A 9-pin DSUB connector to enable
ATS-2 to control other instruments.

§ AUXILIARY CONTROL IN—A 9-pin DSUB connector for external
control and display input.

§ GROUND CONNECTOR—This is connected to chassis ground.

ATS-2 Rear Panel Chapter 3: Hardware Overview
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Chapter 4
ATS-2 User Interface

Overview

ATS-2 is con trolled by the ATS soft ware run ning on the con trol ler PC
via the Au dio Pre ci sion In ter face Bus (APIB). The hard ware is con fig ured
through set tings in fields on soft ware pan els, and read ings (mea sure ments)
are taken from me ters on other pan els. It is also pos si ble to change set tings 
and col lect read ings pro gram mat i cally using the AP Basic language.

When or dered in the op tional GPIB con fig u ra tion (ATS2G), ATS-2 can
also be con trolled by the in dus try-stan dard IEEE 488.2 Gen eral Pur pose
In ter face Bus (GPIB). GPIB op er a tion is not cov ered in this chap ter. See
Chap ter 7 for more in for ma tion about the ATS-2 GPIB configuration.

Like many Win dows ap pli ca tions, the ATS user in ter face has a menu
bar, a sta tus bar, toolbars, and a workspace. With these tools you can save
test and data files, ex port and print mea sure ment re sults, con fig ure the
hard ware and soft ware to your needs, ac cess on line help, de sign and
launch au to mated pro cesses and, of course, open and op er ate the in stru -
ment pan els where the core test and mea sure ment work is performed.

The ATS soft ware is a pow er ful and com plex pro gram. This chap ter pro -
vides a quick in tro duc tion to its fea tures. For an in-depth dis cus sion, re fer
to the ATS-2 User’s Man ual.

A Note on Nomenclature

In this chap ter we use the fol low ing short hand:

§ Menu > Item. This refers to choosing an item from one of the
pull-down menus located at the top of the workspace. For instance,

‘choose Utilities > Restore’ means that you select the Utilities
pull-down menu, then click on the Restore item.
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Starting up the ATS Software

As part of the ATS in stal la tion pro cess, an ‘ATS’ icon is placed on the
desk top of your PC. Click on this icon to start the soft ware. If you have an
ATS-2 in stru ment con nected and switched on, the soft ware will au to mat i -
cally de tect the hard ware and ini tial ize it. If you do not have hard ware
con nected, or it is not switched on, the soft ware will prompt you to start
demo mode. At this point, you have three options:

§ Choose Try Again if you have connected and switched on the
ATS-2 instrument.

§ Choose Demo Mode. In this mode, the software presents panels
and menus as if hardware were connected, but panel meters show
random data. This mode can be used for creating tests, editing data,
etc.

§ Choose Cancel to exit the software.

If you have cho sen to run the soft ware, ATS will start up and show the
workspace.

ATS Workspace

The ATS workspace has five pages that you can se lect by menu com -
mands (View > Page #) or by click ing the num bered tabs on the Sta tus
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Bar. The workspace is a multi-lay ered desk top where you can dis play and
or ga nize the in stru ment pan els you are us ing for a par tic u lar set of tests.

ATS Panels

In ter ac tion with ATS-2 is per formed through con trol and mea sure ment
win dows called pan els. These du pli cate the func tion of phys i cal con trol
pan els found on con ven tional test and mea sure ment equip ment. The pan -
els are avail able through menu com mands, toolbar icons, and keyboard
shortcuts.

A panel can be placed on one or more workspace pages. (Du pli cate
pan els show the same in for ma tion.) Many pan els come in two sizes, the
smaller hav ing the most com monly used fields vis i ble, and the larger show -
ing ev ery op tion. Dou ble-click on a panel ti tle bar to ex pand or con tract
the panel.

You can min i mize or close a panel with out can cel ing its func tion or ef -
fect. For ex am ple, you can set a sig nal’s out put volt age and fre quency on
the gen er a tor panel, and then close the panel win dow. The sig nal will con -
tinue at those set tings un til you turn the gen er a tor OFF.

ATS Panels Chapter 4: ATS-2 User Interface
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Panel Settings

Set tings for tests and mea sure ments are made us ing sev eral dif fer ent
con trols on the pan els:

§ Setting fields, which come in several versions:

� A Windows text box, in which you can directly enter a value from
the keyboard.

� A Windows drop-down list box, from which you can make a
selection of a fixed number of choices.

� A combination text box with an added drop-down list from which
you can choose the units to express your value.

 Setting fields display black characters on a white field, except when
an EQ waveform is selected, when the generator amplitude fields
show blue text.

§ Check boxes, which allow you to set non-exclusive conditions.

§ Option buttons, which provide for exclusive conditions.

§ Browser buttons, which open Windows browsers. These allow you to
navigate lists of options, search for a file by browsing through a
hierarchy of folders, and so on. Browser buttons are identified by the
ellipsis mark ( … ).

§ Custom buttons, which have a special function, such as GO, ON,
OFF, and so on.

§ Sliders, with which you can continuously adjust a value. Sliders are
found on Bar-Graph panels and the Volume Bar. Sliders can be
operated by the mouse pointer or the arrow keys.

Panel Readings

Re sults of tests or mea sure ments are called read ings, which ATS-2 can
dis play in sev eral ways:

§ Reading fields, sometimes called meters. Reading fields come in two
variations, with and without a drop-down list to select units. Reading
fields display green characters on a black field.

§ Status indicators, which show the presence or absence of a condition
by a small colored rectangle.

§ Bar-graphs, which display values as a continuous colored bar, like a
conventional analog meter.
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ATS Menus

The Menu bar ex tends across the top of the ATS workspace and is al -
ways vis i ble. Here, we give a brief over view of each menu item. Please re -
fer to Chap ter 2 of the ATS-2 User’s Man ual for more de tails.

File Menu

The File menu of fers com mands for open ing, sav ing, ap pend ing, im -
port ing, ex port ing and print ing ATS files, and ac cess ing the Quick Launch
menu.

Since there are sev eral file types used by ATS, submenus are avail able
(at the small black ar rows } ac com pa ny ing some menu choices) to choose, 
for ex am ple, whether to Save As a Test, Data, or Macro file.

The list ings at the bot tom of the File menu show the last tests opened by 
ATS, and pro vide a con ve nient way to open a re cent test.

Edit Menu

The Edit Menu pro vides ed it ing com mands. The stan dard Win dows ed -
it ing func tions Undo, Cut, Copy, and Paste are avail able, to gether with
func tions unique to ATS. Con sult the ATS-2 User’s Man ual for details.

View Menu

The View menu al lows you to se lect which workspace page is vis i ble,
and which toolbars are dis played. A checkmark next to a View menu item
in di cates that the se lec tion is vis i ble. See the Toolbars and But tons sec tion
be low for more in for ma tion on toolbars.

Panels Menu

The Pan els menu al lows you to se lect which pan els are vis i ble on the
cur rent page. It du pli cates the func tions of the Panel toolbar, de scribed
below.

Sweep Menu

The Sweep menu con trols op er a tion of the sweep. The sweep is the fun -
da men tal method used to col lect mea sure ments in ATS. For more in for ma -
tion, see Chap ter 5 of this man ual, and Chap ter 15 of the ATS-2 User’s
Man ual.

ATS Menus Chapter 4: ATS-2 User Interface
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Compute Menu

The Com pute menu gives ac cess to ATS’s built-in post-pro cess ing func -
tions. Data col lected dur ing a sweep is avail able for post-pro cess ing. See
Chap ter 19 of the ATS-2 User’s Man ual for details.

Macro Menu

The Macro menu al lows you to ac cess the ed it ing and de bug ging func -
tions for AP Ba sic mac ros. AP Ba sic is the pro gram ming lan guage sup plied 
with ATS, and mac ros can be writ ten to con trol all as pects of ATS-2 func -
tion al ity. See Chap ter 23 of the ATS-2 User’s Man ual for details.

Utilities Menu

The Util i ties menu al lows you to ini tial ize and con fig ure the hard ware,
and ma nip u late the sys tem log file. It also launches the multitone cre ation
tool. See Chap ter 25 of the ATS-2 User’s Man ual for details.

Window Menu

The Win dow menu lists the cur rent open pan els and al lows them to be
ar ranged au to mat i cally in the workspace.

Help Menu

The Help menu al lows you to ac cess ATS’s on-line help sys tem. You can 
also use the F1 key to ac cess help for a par tic u lar con trol or panel field.

Status Bar

The Sta tus bar runs across the bot tom of the workspace. The left por tion 
dis plays the fol low ing in for ma tion:

§ Current hardware status.

§ Information about the button or menu item currently under the
mouse pointer.

At the right, the Sta tus bar shows the workspace page tabs. A bold tab
la bel in di cates that a page con tains at least one panel. The cur rently dis -
played page is high lighted. Click on a tab to switch pages.
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Toolbars and Buttons

ATS has five toolbars for quick ac cess to pan els and com mon func tions.
The toolbars can float at any lo ca tion in the workspace, or they can be
docked to the Menu bar. Whether float ing or docked, the toolbars ap pear
on ev ery workspace page.

But tons on the toolbars con trol ATS func tions. A ToolTip de scrib ing the
but ton’s func tion ap pears when the mouse is held over a but ton for a short 
time. See Chap ter 2 of the ATS-2 User’s Man ual for more in for ma tion.

Standard Toolbar

The Stan dard toolbar gives you quick ac cess to ATS file, printer and ed -
it ing op er a tions, as well as Sweep Stop/Start and Sweep Spec trum/Wave -
form switch ing. 

Panels Toolbar

The Pan els toolbar gives you quick ac cess to com monly used ATS pan -
els. The pan els are also avail able from the Pan els menu.

Macro Toolbar

The Macro toolbar of fers op er a tions for run ning and ed it ing an AP Ba -
sic Macro. See Chap ter 23 of the ATS-2 User’s Man ual for ex pla na tions of
Macro toolbar but ton functions.
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Learn Mode Toolbar

The Learn Mode toolbar gives you the abil ity to turn Learn Mode on
and off. Learn Mode logs your ATS op er a tions as you per form them,
build ing a macro for au to ma tion pur poses. See Chap ter 23 of the ATS-2
User’s Man ual for more in for ma tion on Learn Mode.

Quick Launch Toolbar

The Quick Launch toolbar al lows you to ac cess user-de fined func tions.
You can cre ate Quick Launch but tons to open ATS tests, run AP Ba sic
mac ros, and launch other Win dows pro grams. See Chap ter 2 of the ATS-2 
User’s Man ual for in struc tions on cus tom iz ing and us ing the Quick Launch 
toolbar.

Using Files with ATS

Part of the power of ATS is its abil ity to cre ate, store, load, and run files
which con tain test setup and mea sure ment data in for ma tion. The pri mary
doc u ment in the ATS soft ware is the test, al though ATS uses other file
types as well.

Test Files

When you first launch ATS, a de fault setup is loaded. You can mod ify
this ini tial setup by open ing or clos ing pan els, chang ing con fig u ra tion,
mak ing set tings, run ning a sweep, and so on. You can then save your cus -
tom setup as a test. ATS saves the in stru ment and sweep setup in for ma -
tion, the in put and out put con fig u ra tion, and the panel sizes and po si tions. 
If you have run a sweep and col lected data, the data is also saved in the
test file.

The file name ex ten sion for test files is:

§ ATS-2 test file—*.ats2
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To re turn to the de fault setup, click the New Test but ton or the
File > New > Test com mand. ATS will dis card your cur rent set tings and
data and re load the de fault setup.

You can open pre vi ously saved tests and use them as they are, or you
can mod ify and re-save the tests un der the same name or a new name.
Sam ple tests are in cluded with ATS-2, and you can use them as start ing
points for your own cus tom tests.

Macro Files

A macro file is a pro gram ming script which au to mates pro gram func -
tions. ATS mac ros are writ ten in the AP Ba sic pro gram ming lan guage,
which is in cluded with ATS.

The file name ex ten sion for macro files is:

§ AP Basic macro file—*.atsb

Data Files

ATS stores data from test re sults in mem ory as the test is run. As men -
tioned, this in for ma tion is saved along with panel and sweep setup in for -
ma tion in a test file. The data can also be viewed and ed ited in the Data
Ed i tor panel, and can be saved as a sep a rate file.

ATS can open saved data files to at tach pre vi ous data to a cur rent test.
There are four dif fer ent data file types:

§ AP data file—*.atsa

§ AP limit file—*.atsl

§ AP sweep file—*.atss

§ AP EQ file—*.atsq

The four ATS data file types are identical except for their

filename extensions. Data saved as *.atsa, *.atsl, *.atss or

*.atsq files can be opened or attached for any data function.

The four filename extensions serve as a way to organize your 

data files.

It is also pos si ble to ex port ATS data as an ASCII text file for use in a
spread sheet or text ed i tor pro gram. The file name ex ten sion for an ASCII
data file is:

§ AP ASCII data file—*.atsx

Using Files with ATS Chapter 4: ATS-2 User Interface
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Waveform Files

For cer tain func tions, in clud ing FFT dis plays and some types of in ter -
face anal y sis, ATS-2 ac quires a sam ple of the in put wave form. These sam -
ples can be saved as wave form files and later opened by ATS for further
use.

The file name ex ten sions for wave form files are:

§ AP stereo waveform file (generator)—*.ags

§ AP stereo waveform file (analyzer)—*.aas

§ AP mono waveform file (generator)—*.agm

§ AP mono waveform file (analyzer)—*.aam

§ AP digital interface waveform file—*.aai

Log File

ATS can gen er ate a log file for de bug ging. The log file con tains er ror
mes sages, file and sweep ac tiv ity, graph in for ma tion, and pass/fail test
results.

The file name ex ten sion for the log file is:

§ AP log file—*.alg

The log file is en abled and set up on the Con fig u ra tion panel, and is dis -
cussed in de tail in Chap ter 25 of the ATS-2 User’s Man ual.

Downloadable Filter Files

ATS-2 can make use of cus tom fil ters de signed and down loaded by the
user. Down load able fil ters are de fined in text files whose for mat is de -
scribed in Ap pen dix D of the ATS-2 User’s Man ual.

The file name ex ten sions for down load able fil ter files are:

§ AP downloadable lowpass filter file—*.afl

§ AP downloadable highpass filter file—*.afh

§ AP downloadable weighting filter file—*.afw

The use of down load able fil ters is de scribed in de tail in Chap ter 10 of
the ATS-2 User’s Man ual.
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Chapter 5
Quick Guides

Introduction

The Quick Guides in this chap ter pro vide a way to get used to the ATS
user in ter face, and to get some im me di ate re sults from ATS-2. As you be -
come more fa mil iar with the sys tem, please re fer to the ATS-2 User’s Man -
ual for fur ther in for ma tion.

The Quick Guides be gin with the as sump tion that ATS-2 is turned on
and con nected to your PC, and that the ATS soft ware has been launched
and is prop erly con trol ling your in stru ment. No ca bles or ex ter nal de vices
are needed for the Quick Guides.

Quick Guide to the Analog Signal Path

When the ATS soft ware is launched, the de fault workspace is loaded
with three pan els, la beled An a log Gen er a tor, An a log In put, and An a -
lyzer. To re turn to this con fig u ra tion at any time, click the New Test but -
ton. Pre vi ous set tings and data will be discarded.

Analog Input Panel

ATS-2 has two chan nels of an a log in put. Each chan nel can re ceive a
sig nal from its front panel XLR con nec tor, its front panel BNC con nec tor,
or via an in ter nal path from the an a log gen er a tor. The Source fields on
the An a log In put panel pres ent these choices as a drop-down list.
Choose ‘GenMon’ for each chan nel to en gage the internal path.

Analog Generator Panel

In the de fault con fig u ra tion, the An a log Gen er a tor panel is set for a
1 V, 1 kHz sine wave, but the an a log out puts are dis abled. To turn on
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the out puts, click the OUTPUTS “OFF” but ton near the cen ter of the
panel. The but ton will turn green, and you will hear re lays click in the
ATS-2 hard ware. The peak me ters in the an a log in put panel will show ap -
prox i mately 1.414 Vpp. The peak me ters in di cate the pres ence of signal at
the analog inputs.

The ste reo gen er a tor out puts can be in di vid u ally dis abled with the
‘CHA’ and ‘CHB’ but tons next to the ‘OUTPUTS’ field. Click on the ‘CHB’ 
but ton. The but ton will turn gray, re lays will click in the hard ware, and the
Chan nel B peak me ter on the an a log in put panel will in di cate a level close
to zero.

Analyzer Panel

The de fault An a lyzer panel is a real-time au dio an a lyzer. It pro vides
con tin u ous read ings of sig nal level and fre quency. It also al lows you to fil -
ter the au dio sig nal and mea sure pa ram e ters such as to tal har monic dis tor -
tion, phase, and so on. It is a ste reo in stru ment, with the me ters on the left
of the panel re port ing chan nel A read ings, and those on the right reporting 
channel B readings.

At this point, you should have the setup shown in Fig ure 15:

§ Analog generator channel A producing a 1 V, 1 kHz sine wave.

§ Analog generator channel B disabled.

§ Analog inputs A and B set to the internal generator path (GenMon).

The top most me ters in the de fault An a lyzer panel show the au dio level
in V rms. You should see ap prox i mately 1 V in the left-hand me ter (chan -
nel A), and ap prox i mately 0 V in the right-hand me ter (chan nel B). Click
the ‘CHB’ but ton on the An a log Gen er a tor panel to re-en able the chan nel
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B gen er a tor sig nal. You now see ap prox i mately 1 V in the right-hand level
me ter on the An a lyzer panel, since the chan nel B gen er a tor is now ac tive
and its sig nal is be ing routed to the analyzer via the GenMon internal path.

The me ters in the next row of the An a lyzer panel show the fre quency of
the sig nal in each chan nel. Both of these me ters should be show ing 1 kHz,
the fre quency of the an a log gen er a tor.

Signal Monitor

ATS-2 has an in ter nal mono speaker to mon i tor both an a log and dig i tal
in put sig nals. In ad di tion, the sig nal at the speaker is avail able (also in
mono) at the head phone jack on the back of the in stru ment. When a
head phone plug is in serted into the jack, the in ter nal speaker is
disconnected.

By de fault, the vol ume con trol for the speaker is be low the toolbars near 
the top of the ATS workspace. Move the vol ume slider con trol to the right
with the mouse. You will hear the 1 kHz tone from the gen er a tor be come
louder. In the de fault setup, the speaker mon i tors the sig nal pre sented to
chan nel A of the an a log an a lyzer. Click the ‘CHA’ but ton on the an a log
gen er a tor to dis able the chan nel A gen er a tor. The speaker will no longer
emit the 1 kHz tone.

Controlling the Analog Generator

The top most two fields in the An a log Gen er a tor panel con trol the gen er -
a tor wave form. The an a log gen er a tor is ca pa ble of pro duc ing sine waves,
square waves, noise, and other wave forms. At this point the wave form
should be set to Sine/Nor mal. Pull down the left-hand list box and
choose Square to change the wave form to a square wave. If you are
mon i tor ing the sig nal with the in ter nal speaker, you will hear the tim bre of
the sig nal change. You will also see the sig nal level change in the An a lyzer
panel. (The square wave has a higher rms level than the sine wave for a
given amplitude setting.)

The square wave form has one pa ram e ter or set ting: the fre quency.
This is set in the field be low the wave form se lec tion fields. We will now
change the gen er a tor fre quency to 2 kHz, as follows:

§ Click in the Frequency field in the Analog Generator panel. The text
‘1.00000 kHz’ becomes highlighted in blue.

§ Use the keyboard to type ‘2k’, the new generator frequency. As you
can hear in the monitor speaker, the frequency does not change.

§ Hit ‘enter’. The text changes to ‘2.00000 kHz’, the pitch increases
from the monitor speaker, and the frequency reading in the Analyzer
panel changes to 2.00000 kHz.
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Now switch the wave form type back to sine. The cur rent square wave
fre quency is used for the sine wave.

You can enter standard SI prefixes for multipliers as you

enter the value in the setting field. For example, ‘2000’, ‘2k’,

‘0.002M’, and ‘2000000m’ all produce the same frequency.

All wave forms can be gen er ated at any am pli tude from 0 V to the
max i mum out put volt age of the in stru ment. The am pli tude for each chan -
nel is con trolled by fields be low the ‘OUTPUTS’ field. If the ‘Track A’ se lec -
tion is checked, the am pli tude is iden ti cal in both chan nels and is set by
the chan nel A Am pli tude field at the left of the panel. If ‘Track A’ is un -
checked, a chan nel B Am pli tude field ap pears at the right of the panel,
and the am pli tudes of the two chan nels can be varied independently.

Change the chan nel A am pli tude to 0.5 V by click ing in the Am pli tude
field on the An a log Gen er a tor panel, typ ing ‘0.5’, and hit ting en ter. The
level me ter read ing on the An a lyzer panel will change. (You will also hear
re lays click if the sys tem needs to change the an a log range.) Now uncheck
‘Track A’ and set the chan nel B am pli tude to 10 V. The level me ters on the
An a lyzer panel will show the dif fer ent lev els. Both fre quency me ters, how -
ever, will show the same fre quency. This is be cause the Sine/Nor mal wave -
form gen er ates iden ti cal frequencies in the two channels.

The Sine/Ste reo wave form, which is ob tained by choos ing Sine from
the left-hand wave form field and Ste reo from the right-hand wave form
field, gen er ates in de pend ent fre quen cies in the two chan nels. You can ver -
ify the fre quency in each chan nel by re fer ring to the fre quency me ters on
the Analyzer panel.

Units

Set tings and read ings con sist of a value and a unit. ATS can con vert the
units of a set ting or read ing to a re lated unit. For in stance, the an a log gen -
er a tor am pli tude can be set in Vp (volts peak), dBV (deci bels rel a tive to
1 V), and sev eral other units. Sim i larly, read ings can be dis played on a
me ter in any of the related units.

The list of units for a set ting or read ing can be viewed by click ing the
down ward-point ing ar row next to the set ting or read ing field. For in stance, 
the list of units for the an a log gen er a tor am pli tude can be dis played by
click ing on the ar row next to the Am pli tude field on the An a log Gen er a tor
panel. ATS dis plays the value cur rently in the field, con verted to each
avail able unit. By click ing on the list, you can choose a setting unit.

As an ex am ple, if the am pli tude is set to 1 Vrms, the drop-down list in -
cludes con ver sions such as 1.414 Vp and 2.220 dBu. If you click on the
line dis play ing the am pli tude in Vp, the set ting changes to 1.414 Vp. The
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gen er a tor am pli tude has not changed; the set ting is dis played in a dif fer ent 
unit. You can now set the gen er a tor amplitude in Vp.

Some units, such as dBr, de pend on a ref er ence be ing set. Re fer to Ap -
pen dix A of the ATS-2 User’s Man ual for more in for ma tion.

Quick Guide to Sweeps

Most de vice test ing with ATS-2 is per formed with sweeps. In a sweep, a
set ting is stepped over a pre-de fined range, while se lected read ings are
gath ered. The re sult is a ta ble of data re lat ing the read ings to each value of 
the setting.

For in stance, if you wanted to mea sure the fre quency re sponse of an an -
a log am pli fier, you might vary the fre quency of the an a log gen er a tor from
20 Hz to 20 kHz in 30 log a rith mic steps, while mon i tor ing the an a lyzer
chan nel A and chan nel B level read ings. The re sult would be a ta ble of
data with 30 rows (one for each fre quency step) and 3 col umns (one for
the fre quency set ting, one for the chan nel A level read ing, and one for the
channel B level reading).

You can force ATS-2 to perform a “single-point sweep” for

special purposes, but generally the term sweep indicates that 

a number of data points are included in the measurement.

When a sweep is per formed, a graph is also cre ated. This is a graph i cal
rep re sen ta tion of the data ob tained dur ing the sweep. Fig ure 16 shows an
ex am ple of a ste reo fre quency re sponse graph.

This sec tion is an in tro duc tion to sweeps. The Sweep panel con tains
many more fea tures that are de scribed in Chap ter 15 of the ATS-2 User’s
Man ual.
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Sweep Fundamentals

Settings and Readings

To set up a sweep, open the Sweep panel, ei ther by choos ing Pan -
els > Sweep, or by click ing on the Sweep but ton. The Sweep panel is di -
vided hor i zon tally into two ma jor ar eas: the Data (read ing) area above,
and the Source (set ting) area be low. Dur ing the sweep, the set ting cho sen 
in the Source 1 field is var ied, and the read ings spec i fied in the Data fields
are gathered.

To choose the set ting to be var ied, click on the el lip sis but ton to the
right of the Source 1 field. In the browser, choose an in stru ment from the
left pane and a set ting from the right pane. For in stance, if you choose ‘An -
a log Gen er a tor’ from the in stru ment side and ‘Fre quency’ from the set ting
side, the fre quency of the an a log gen er a tor will be var ied dur ing the
sweep. This is shown in the Source 1 field as ‘An a log
Generator.Frequency’.

To choose a read ing to be gath ered, click on the el lip sis but ton to the
right of the Data 1 field. The browser shows in stru ments in the left pane
and read ings in the right pane. If you choose the ‘An a lyzer’ in stru ment and 
the ‘Level A’ read ing, the level on chan nel A will be re corded dur ing the
sweep. This is shown in the Data 1 field as ‘An a lyzer.Level A’.

The Ste reo Sweep checkbox near the bot tom of the Sweep panel au -
to mat i cally en sures that read ings from both chan nels are gath ered dur ing
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the sweep. For in stance, if you choose An a lyzer.Level A as the read ing in
Data 1 and then check the Ste reo Sweep checkbox, the read ing An a -
lyzer.Level B will also be gath ered during the sweep.

Source Range, Steps, and Spacing

Dur ing the sweep, the set ting in Source 1 is stepped from the Start
value to the Stop value shown in fields be low Source 1. The num ber of
steps in the sweep is shown in the Steps field. A ra dio but ton to the right
of these fields con trols whether suc ces sive set tings are sep a rated lin early
or logarithmically. In a lin ear sweep, the dif fer ence be tween suc ces sive
set tings is con stant. In a log a rith mic sweep, the ra tio be tween suc ces sive
settings is constant.

For ex am ple, if the start fre quency is 20 Hz, the stop fre quency is
20 kHz, there are 3 steps, and the spac ing is log a rith mic, ATS will first set
the gen er a tor to 20 Hz, then 200 Hz, then 2 kHz, and fi nally 20 kHz. That
is, the ra tio be tween suc ces sive fre quency settings is 10.

On the other hand, if the spac ing is lin ear, the gen er a tor is first set to
20 Hz, then 6680 Hz, then 13340 Hz, and fi nally 20 kHz. That is, the dif -
fer ence be tween suc ces sive fre quency set tings is 6660 Hz.

Data Display Range

A graph is au to mat i cally cre ated when a sweep is run. The Start and
Stop val ues for Source 1 de fine the ex tent of the hor i zon tal (x-) axis. The
ex tent of the ver ti cal (y-) axis is de ter mined by the val ues in the Top and
Bot tom fields beneath Data 1.

The units of the y-axis are the same as the units in the Top and Bot tom
fields. If you change the units of the Top or Bot tom field, the units in the
other field will also change. See the Units sec tion on page 34 for more in -
for ma tion on units. 
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We will now per form two ex am ple sweeps: a fre quency re sponse sweep, 
and an am pli tude lin ear ity sweep.

Example Sweep: Frequency Response

For this ex am ple, we will mea sure the fre quency re sponse flat ness of the
ATS-2 it self. We con nect the an a log out put to the an a log in put, sweep the
fre quency of the an a log gen er a tor over the au dio range, and plot the level
mea sured by the an a lyzer against frequency.

First, click the New Test but ton, turn the an a log gen er a tor on, and set
both an a log in put chan nels to GenMon so that the gen er a tor sig nal is sent
di rectly to the an a log in put. Now open the Sweep panel. The de fault
sweep is a mono fre quency re sponse sweep, so we only have to make a
few modifications:

§ Check the Stereo Sweep box to create a stereo sweep.

§ Change the Steps from 30 to 100 for a more detailed response.

§ The default range for Data 1 is quite wide, and the units are Volts.
Change the units to dBV by clicking on the arrow next to the Top
field. From the list, choose the ‘dBV’ line. (Note that the units in the
Bottom field change also.) In the Top field, type ‘0.1’. In the Bottom
field, type ‘–0.1’.

You can now click the Go but ton to run the sweep. A graph is cre ated,
and the re sponse is plot ted as the sweep pro gresses. If you are mon i tor ing
us ing the in ter nal speaker, you will hear the an a log gen er a tor fre quency
step through the au dio range. The re sult will be a re sponse curve that de vi -
ates only slightly from 0 dBV, as shown in Fig ure 18.
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Review

To set up a sweep, you must:

§ set Source 1 to the setting to be varied during the sweep;

§ set Data 1 to the reading to be collected during the sweep;

§ click Stereo Sweep to collect data from both channels;

§ set the Start, Stop, Steps, and Lin/Log for Source 1; and

§ set the Top and Bottom values and units for Data 1.

Once the sweep is set up, you can run it by click ing the Go but ton at
the bot tom of the Sweep panel.



Example Sweep: Amplitude Linearity

For this ex am ple, we will mea sure the am pli tude lin ear ity of the ATS-2.
With the an a log out put con nected to the an a log in put, we sweep the am -
pli tude of the an a log gen er a tor over its full range, and plot the ra tio of the
level mea sured by the an a lyzer to the gen er a tor out put level, in dB. Any
am pli tude non-lin ear ity in the sys tem will show as a deviation from 0 dB.

First, per form a New Test, turn the an a log gen er a tor on, and set both
an a log in put chan nels to GenMon so that the gen er a tor sig nal is sent di -
rectly to the an a log in put. Now open the Sweep panel and make the fol -
low ing changes:

§ Click the Source 1 browser button, and choose ‘Analog Generator’ as 
the instrument and ‘ChA Amplitude’ as the setting.

§ Change the Start value for Source 1 to 100 µV. (ATS understands the 
prefix ‘u’ to stand for ‘µ’.)

§ Choose the dBg A units for Data 1 by clicking on the arrow next to
the Top field, and choosing the ‘dBg A’ line from the list. The dBg A
units (decibels relative to generator channel A) show the ratio of the
reading to the level of the analog generator, in dB.

§ Set the Data 1 Top value to 0.1, and the Bottom value to –0.1.

Click Go to start the sweep. The rang ing re lays will click as the gen er a -
tor changes am pli tude. The re sult will be a curve that de vi ates only slightly
from 0 dBg A, as shown in Fig ure 19.
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Quick Guide to the FFT Spectrum Analyzer

At the top of the An a lyzer panel is a drop-down list of the in stru ments
avail able in ATS. Up to this point, we have been us ing the au dio an a lyzer
to make mea sure ments. We will now take a look at the FFT spec trum an a -
lyzer. This in stru ment dis plays au dio sig nals in time (os cil lo scope-style)
and in fre quency (spec trum an a lyzer-style). It op er ates in a dif fer ent fash -
ion from the au dio analyzer, as explained next.

Real-Time vs. Batch-Mode Instruments

The au dio an a lyzer is a real-time in stru ment. That is, it re turns read ings
con tin u ously, whether or not a sweep is in prog ress. These read ings in -
clude level and fre quency, as well as func tions such as dis tor tion or phase.
Dur ing a sweep, read ings from the au dio an a lyzer are di verted from the
panel me ters to the sweep en gine for graph ing. Af ter the sweep, the read -
ings are once again dis played in the panel meters.

By con trast, the FFT spec trum an a lyzer is a batch-mode in stru ment. It
does not gen er ate read ings if a sweep is not be ing per formed. When a
sweep is started, the spec trum an a lyzer first ac quires a seg ment of au dio
by stor ing it in mem ory. This is in di cated on the Sta tus bar as ‘DSP Ac quir -
ing Data’. Once the ac qui si tion is com plete, the spec trum an a lyzer pro -
cesses the data. This is in di cated as ‘DSP Trans form ing Data’ on the Sta tus 
bar. Once pro cess ing is com plete, ATS fetches a batch of read ings from the 
spec trum an a lyzer. At that point, the data is graphed.
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The FFT Concept

The FFT (fast Fou rier trans form) is an ef fi cient way to de com pose a pe -
ri odic sig nal into its com po nent fre quen cies. It trans forms a time-do main
sig nal (such as you might see in an os cil lo scope trace) into a fre quency-do -
main rep re sen ta tion.

As an ex am ple, a high-qual ity power am pli fier fed with a si nu soi dal in -
put will pro duce har monic dis tor tion at its out put that is in vis i ble in an os -
cil lo scope trace. If an FFT is per formed on the out put sig nal, how ever, the
in di vid ual dis tor tion har mon ics can be seen. The pat tern of har mon ics
pro vides in sight into the mech a nisms responsible for the distortion.

The FFT pro cess con sists of the fol low ing steps:

§ Triggering. The system waits for a trigger event from the selected
source, for instance, a positive-going zero crossing of the analog
generator.

§ Acquisition. The system stores the input audio in memory until the
selected number of audio samples has been received. The more
audio data acquired, the more frequency points there will be in the
result, and hence the higher the resolution will be. However, longer
acquisitions take more time.

§ Windowing. Before transformation, the audio data is shaped in time
by multiplying it with a pre-defined envelope. This increases the
accuracy of the amplitude values returned from the FFT.

§ Transformation. The windowed audio data is transformed by the
FFT. This results in an array of points describing the magnitude and
phase of each frequency in the audio signal.

§ Display. ATS fetches the transformed audio data and graphs it.
Because the number of transformed points is typically larger than the
number of points in the graph, a peak-picking method is used to
ensure that peaks in the frequency data are not missed.

For more in for ma tion, see Ap pen dix C of the ATS-2 User’s Man ual.

Setting up an FFT

Af ter a New Test, ATS de faults to the au dio an a lyzer. To switch to the
spec trum an a lyzer, click the down ar row next to the In stru ment field at the
top of the An a lyzer panel. From the list of in stru ments, choose FFT Spec -
trum An a lyzer. The panel changes to dis play the new instrument.
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Panel Fields

There are two peak mon i tors near the top of the panel, one for each of
the ste reo chan nels. These me ters give an in di ca tion of the pres ence of sig -
nal at the FFT input.

Be low the peak me ters is an ar ray of fields for con fig ur ing the an a lyzer.
Here, we will use the de fault set tings. For more de tails on the set tings, see
Chap ter 11 of the ATS-2 User’s Man ual.

Time vs. Frequency

As men tioned, the FFT spec trum an a lyzer can dis play au dio sig nals in
the time do main and the fre quency do main. The choice of do main is de -
ter mined by the Source 1 field on the Sweep panel. If it is set to FFT.Time,
a time do main dis play re sults. If it is set to FFT.Fre quency, a fre quency do -
main display results.

The Sweep Spec trum/Wave form but ton in the stan dard toolbar al lows
FFT sweeps to be set up quickly. We will use this fea ture to ex am ine har -
monic dis tor tion in the ATS-2 system.

Quick Sweep Setup

First, per form a New Test, turn the an a log gen er a tor on, and set both
an a log in put chan nels to GenMon so that the gen er a tor sig nal is sent di -
rectly to the an a log in put. Choose FFT Spec trum An a lyzer from the In stru -
ment field at the top of the Analyzer panel.

Bring up the Sweep panel and click the Sweep Spec trum/Wave form
but ton on the Stan dard toolbar. The sweep is au to mat i cally set up for a
ste reo fre quency do main dis play from 20 Hz to 20 kHz. Click Go to per -
form the sweep. A graph sim i lar to Fig ure 20 is created.
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Figure 20. Typical default

FFT stereo frequency

domain graph.



The large peak in the mid dle of the spec trum is the 1 kHz, 1 V sine
wave fun da men tal pro duced by the an a log gen er a tor. There are smaller
peaks spaced at 1 kHz in ter vals above the fun da men tal. These are har -
monic dis tor tion com po nents gen er ated in the ATS-2 hard ware. These
har mon ics rise out of a wideband sys tem noise floor.

To look at the au dio sig nal in the time do main, click the Sweep Spec -
trum/Wave form but ton again. Source 1 changes to FFT.Time and the
graph up dates to show the new data. You should see a graph sim i lar to
Fig ure 20.

 The dis play shows a sine wave with a pe riod of 1 ms (cor re spond ing to
a fre quency of 1 kHz) and a peak ex cur sion of 1.414 V (cor re spond ing to
an am pli tude of 1 Vrms). The ef fect of the dis tor tion on the wave form is
not vis i ble in the time domain.

You can switch be tween the time do main and fre quency do main dis -
plays at any time by click ing the Sweep Spec trum/Wave form but ton.

Fine-Tuning the Display

There are sev eral ways to ad just the graph dis play to more closely ex -
am ine fea tures of the ac quired wave form:

§ Zoom. On the graph, draw a box by holding down the left mouse
button and moving the mouse. When you release the button, ATS
zooms the selected area to the full graph size.

§ Zoomout. After zooming, click the right mouse button on the graph.
From this right-click menu, choose Zoomout. The graph zooms out to 
the pre-zoom size.

§ Optimize. From the right-click menu, choose Optimize Left Only. The 
vertical axis changes to best fit the data in the graph.

Quick Guide to the FFT Spectrum Analyzer Chapter 5: Quick Guides
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Figure 21. Typical default

FFT stereo time domain

graph.



For more de tails, see Chap ter 16 of the ATS-2 User’s Man ual.

Saving and Loading Tests

At any time, the cur rent workspace setup can be saved to a file. The file
con tains the set tings on all the pan els (in clud ing pan els that are not vis i ble
in the workspace), the panel po si tions, and ref er ences to any other files
that were at tached, such as limit data. The file also con tains the most re -
cent data ob tained from any sweeps that were run.

When a test is loaded, the workspace re verts to the ex act con fig u ra tion
it had when the test was saved. The data from the test is avail able and can 
be fur ther pro cessed. It can also be re-graphed au to mat i cally when the test 
is loaded. See Chap ter 25 of the ATS-2 User’s Man ual for more details.

To save the cur rent workspace, choose File > Save > Test, or click
the Save Test but ton in the Stan dard toolbar. To load a lest, choose
File > Open > Test, or click the Open Test but ton in the Stan dard
toolbar.

The Next Step

In this chap ter, we have in tro duced two in stru ments: the au dio an a lyzer, 
and the FFT spec trum an a lyzer. ATS has other in stru ments to mea sure au -
dio sig nals in dif fer ent ways. The ATS-2 User’s Man ual de scribes all the in -
stru ments in detail.

We have also in tro duced the sweep, which is at the heart of ATS au to -
mated mea sure ments. The sweep en gine and its fea tures are de scribed in
more de tail in Chap ter 15 of the ATS-2 User’s Man ual.

We set up tests by hand us ing the mouse and key board, and saved
them to disk. ATS also con tains a com plete pro gram ming lan guage to al -
low you to ex e cute com plex mea sure ment se quences pro gram mat i cally.
Chap ter 23 of the ATS-2 User’s Man ual de scribes how to pro gram the in -
stru ment, and the AP Ba sic User’s Guide and Lan guage Ref er ence de -
scribes the language itself.
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Chapter 6
Specifications

Unless otherwise noted, all analyzer specifications assume dc coupling, rms
detection, autoranging on, and high resolution conversion at 65.536 kS/s. The
abbreviation “SR” refers to the relevant output or input sample rate
(1 kS/s = 1 kHz).

Analog Signal Generator

Waveforms

Sine Family (Normal, Var Phase, Stereo, Dual,
Shaped Burst, EQ)

IMD (SMPTE/DIN 4:1, 1:1)
Square
Noise
Arbitrary Waveform (Multitone)
Special (Polarity, Pass Thru)

Sine Family Characteristics
Frequency Range 2 Hz–61.6 kHz (SR=131.072 kS/s)1

Frequency Resolution 0.015625 Hz
Flatness (500 Hz ref)

20 Hz to 20 kHz ±0.01 dB
10 Hz to 50 kHz +0.06/–0.1 dB

THD+N2 (20 Hz–20 kHz) ≤0.0009% [–101 dB] +1.6 µV
Variable Phase Range –180.00 to +179.99 deg
Dual Sine Ratio Range 0 dB to >100 dB

Shaped Burst
Envelope Raised cosine

Burst Interval 2 to 65536 cycles (max number of cycles may be
limited at low frequencies)

Burst On Time 1 to number of interval cycles minus 1 

Getting Started with ATS-2 45

NP0020.0002.003

1
Significant alias products may appear for frequency settings above 53.5 kHz.

2
System specification including contributions from both generator and analyzer, 20 kHz
measurement bandwidth.



Other Waveforms

Arbitrary Waveform (Multitone)
Sample Rates (SR) 65.536 kS/s, 131.072 kS/s, OSR (programmed

output rate), or ISR (selected input sample rate)
Length 256 to 16384 points per channel
Frequency Range DC to 0.47×SR
Frequency Resolution Sample Rate / Length
Maximum Number of Tones (Length / 2) minus 1 [8191 with Length=16384]

IMD Test Signal (SMPTE/DIN)
LF Tone Range 40 Hz to 500 Hz
HF Tone Range 2 kHz to 60 kHz
Mix Ratio 4:1 or 1:1 (LF:HF)
Residual IMD3 ≤0.0025% [–92 dB]

Square wave
Frequency Range 10 Hz to 20 kHz
Risetime Typically 2.0 µs

Noise Signal
White Pseudo-Random, Rectangular PDF,  60 kHz BW

Polarity Test Signal

(Sum of two sinewaves phased for reinforcement with normal polarity.)

Frequency Range 2 Hz to 30 kHz

Pass Thru

(Passes the embedded audio signal from the rear panel Sync/Ref Input. Output
Sample Rate (OSR) must be within the range of 0.334 to 3.000 of the Sync/Ref
Input sample rate.)

Frequency Accuracy ±0.0003% [3 PPM] internal reference, lockable to
external reference

Analog Signal Generator Outputs

Analog Output Characteristics

Source Configurations Balanced (XLR), Unbalanced (XLR and BNC), or
Common Mode Test (XLR)
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Source Impedances (Rs)
Balanced or CMTST Nominally 40 Ω or 150 Ω, standard configuration 

Nominally 40 Ω or 200 Ω, EURZ option
Nominally 40 Ω or 600 Ω, 600Z option

Unbalanced Nominally 20 Ω or 50 Ω 
Amplitude Range
(all Waveforms) Each analog output is independently settable

Balanced <250 µVrms to 16.00 Vrms [700 µVpp to
45.2 Vpp] [–70.0 dBu to +26.30 dBu]

Unbalanced or Common
Mode Test <250 µVrms to 8.00 Vrms [700 µVpp to 22.6 Vpp] 

[–70.0 dBu to +20.28 dBu]
Amplitude Accuracy ±0.09 dB [±1.0 %]
Amplitude Resolution 0.007 dB or 0.60 µVrms, whichever is larger
Max Output Power into 600 Ω

Balanced +24.1 dBm (Rs = 40 Ω)
Unbalanced +18.4 dBm (Rs = 20 Ω)

Output Current Limit Typically >50 mA
DC Offset ≤0.25% of Vpp setting [0.7% of Vrms setting]
Output Related Crosstalk ≤(–100 dB + 3 µV), 20 Hz to 20 kHz

Digital Signal Generator

Waveforms

Sine Family (Normal, Var Phase, Stereo, Dual, Shaped Burst,
EQ, Burst, Offset)
IMD (SMPTE/DIN 4:1, 1:1)
Square
Noise
Arbitrary Waveform (Multitone)
Special (Polarity, Pass Thru, Monotonicity, J-Test, 

Walking Ones, Walking Zeros, Constant Value,
Random)

Common Sine Family Characteristics
Frequency Range 2 Hz to <0.50×SR
Frequency Resolution SR / 223

Flatness ±0.001 dB
Harmonics and
Spurious Products 0.000001% [-160 dB]

Variable Phase Range –180.00 to +179.99 deg
Dual Sine Ratio Range 0 dB to >100 dB
Sine + Offset Amplitude Range Sinewave amplitude + |offset amplitude| < 1 FFS

Burst and Shaped Burst
Envelope Burst signal envelope is rectangular, Shaped

Burst envelope is raised cosine.
Burst Interval 2 to 65536 cycles (max number of cycles may be

limited at low frequencies)
Burst On Time 1 to number of interval cycles minus 1 
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Squarewave

Frequency Range 2 Hz to SR / 6, in even integer sub-multiples of
SR

SMPTE/DIN Test Signal
Lower Tone Range 40 Hz to 500 Hz
Upper Tone Range 2 kHz to 0.47×SR
Mix Ratio 1:1 or 4:1 (LF:HF)

Noise Signal
White Pseudo-Random White, Rectangular PDF,

Bandwidth = 0.50×SR

Special Signals
Polarity Sum of two sinewaves phased for reinforcement

with normal polarity
Pass Thru Passes the embedded audio signal from the rear

panel Sync/Ref Input. Output Sample Rate (OSR) 
must be within the range of 0.334 to 3.000 of the
Sync/Ref Input sample rate.

Monotonicity Staircase waveform of lowest 10 levels for D/A
linearity testing

J-Test Produces a maximum amount of data-induced
jitter on low-bandwidth transmission links

Walking Ones A single binary one value “walked” from LSB to
MSB

Walking Zeros A single binary zero value “walked” from LSB to
MSB

Constant Value
(Digital DC) 32-bit resolution when using triangular dither

Random Random binary states of all bits

Arbitrary Waveform (Multitone)
Sample Rates (SR) 65.536 kS/s, 131.072 kS/s, OSR (programmed

output rate), or ISR (selected input sample rate)
Length 256 to 16384 points per channel
Frequency Range DC to 0.47×SR
Frequency Resolution Sample Rate / Length
Maximum Number of Tones (Length / 2) minus 1 [8191 with Length = 16384]

Dither 

Applies to all waveform except Monotonicity, J-Test, Walking Ones, Walking
Zeros, Random

Types None, Triangular, Rectangular, or Shaped
Amplitude 8 to 24 bit 
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Pre-Emphasis Filters

(Applies to all waveforms)

Filter Shapes 50/15 µs or J17
Response Accuracy ±0.02 dB, 10 Hz to 0.45×SR
Residual Distortion 0.00003% [–130 dB]

Digital Signal Generator Outputs

Formats
Balanced (XLR) AES3 per AES3-1997
Unbalanced (BNC) SPDIF-EIAJ per IEC 60958
Optical (Toslink®) per IEC 60958-3

Digital Output Characteristics
Sample Rate Range 28.8 kHz to 108 kHz per connector
Sample Rate Accuracy ±0.0003% [3 PPM] internal reference, lockable to

external reference
Word Width 8 to 24 bits
Output Impedance

Balanced (XLR) Nominally 110 Ω
Unbalanced (BNC) Nominally 75 Ω

Output Amplitude, balanced
into 110 Ω

Range 0 to 5.10 Vpp
Resolution 20 mV
Accuracy ±(10% + 60 mV)

Output Amplitude, unbalanced
into 75 Ω

Range 0 to 1.275 Vpp
Resolution 5 mV
Accuracy ±(8% + 15 mV)

Output Amplitude,
Optical (Toslink®) Nominal intensity, not variable
Channel Status Bits Full implementation per IEC 60958, English

language decoded, common to both channels
Formats Professional or consumer; or Direct Hex source

User Bits Set to 0
Validity Flag Selectable–set or cleared, common to both

channels

Jitter Generator
Waveform Sine
Frequency Range 20 Hz to 200 kHz, <0.1 Hz resolution
Amplitude Range 0.05 to 0.1275 UI in 0.0005 UI steps

0.130 to 1.275 UI in 0.005 UI steps
1.30 to 12.75 UI in 0.05 UI steps

Accuracy (500 Hz) ±(10% + 2 ns)
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Flatness4 ±1 dB, 100 Hz to 20 kHz
Residual Jitter5 ≤2 ns [0.012 UI at 48 kS/s, 0.024 UI at 96 kS/s]
Spurious Jitter Products typically <0.003 UI [–50 dBUI] or 30 dB below

jitter signal, whichever is larger

Audio Analyzer

Level and Amplitude Measurement

(Independent level and amplitude meters per channel)

Measurement Range
Analog <1 µV rms to 140 V rms [–118 dBu to +45.1 dBu]
Digital –120 dBFS to 0 dBFS (usable to –140 dBFS)

Accuracy (1 kHz)
Analog ±0.09 dB [±1.0%]
Digital ±0.002 dB [±0.023%]

Flatness6

Analog ±0.01 dB, 20 Hz to 20 kHz (0.45×SR if less);
±0.10 dB, 10 Hz to 120 kHz (with performance
option)

Digital ±0.002 dB, 10 Hz to 0.45×SR
Detection RMS, FAST RMS, or QPK per IEC 468 (CCIR) 

Frequency Measurement

(Two independent meters, one per channel)

Range
Analog <10 Hz to 30 kHz (SR = 65.536 kS/s),

<10 Hz to 120 kHz (with performance option)
Digital <10 Hz to 0.47×SR

Accuracy ±0.0003% [3 PPM]
Resolution 0.00001% of SR [0.007 Hz at 65.536 kS/s]
Minimum Input

Analog 1 mV (S/N >40 dB)
Digital –100 dBFS (S/N >40 dB)

Phase Measurement
Measurement Ranges ±180, –90 to +270, or 0 to +360 deg
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4
System specification including contributions from both analyzer and generator. Valid at
32.0, 44.1, 48.0, 65.536, 88.2, and 96.0 kS/s only. Flatness may degrade at other
sample rates.

5
System specification valid only if (1) the jitter generator amplitude is turned off; (2) the
digital input is ≥ 1.0 Vpp (XLR) or ≥ 250 mVpp (BNC); and (3) the analyzer is set for
700 Hz–100 kHz bandwidth.

6
1 kHz ref. Flatness derates above 5 kHz by an additional ±0.02 dB in the 22.4 V, 45 V,
90 V, and 200 V input ranges.



Accuracy
Analog7 ±2 deg, 10 Hz to 5 kHz

±3 deg, 5 kHz to 20 kHz
±4 deg, 20 kHz to 50 kHz (with performance
option)

Digital ±1 deg, 10 Hz to 0.45×SR
Resolution 0.01 deg
Minimum Input (both channels)

Analog 1 mV (S/N >40 dB)
Digital –60 dBFS (S/N >40 dB)

Residual Noise

(Amplitude Function only)

Analog
A-weighted ≤1.2 µV rms
Dolby 2K ≤2.0 µV rms
IEC 468 (CCIR) ≤6.0 µV Qpk
20 kHz LP ≤1.6 µV rms

Digital
A-weighted ≤–142 dBFS 
Dolby 2K ≤–134 dBFS 
IEC 468 (CCIR) ≤–127 dBFS 
20 kHz LP ≤–140 dBFS 

THD+N Function
Fundamental Range 10 Hz to 0.47×SR
Measurement Range 0 to 100%
Accuracy ±0.3 dB, 10 Hz to 0.45×SR (no filters selected)
Residual THD+N

Analog ≤0.0009% [–101 dB] + 1.6 µV (with 20 kHz LP)
Digital –138 dBFS

Minimum Input for Counter Tuning
Analog 1 mV (S/N > 40 dB)
Digital –65 dBFS (S/N > 40 dB)

Notch Tuning Modes Counter Tuned, Sweep Track, Agen Track, Dgen
Track, or Fixed (set by direct entry)

Amplitude & THD+N Filters

(One filter from each of the following 3 groups may be enabled for 3 filters total)

Low Pass Group Fs/2 (no BW limiting)
20 kHz (6-pole elliptic, 0.1 dB ripple, 110 dB
stopband)
15 kHz (6-pole elliptic, 0.1 dB ripple, 110 dB
stopband)
User defined (6-pole max)
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High Pass Group <10 Hz (4-pole)
22 Hz (4-pole Butterworth)
100 Hz (4-pole Butterworth)
400 Hz (4-pole Butterworth, or 10-pole elliptic if
no other filters are enabled)
User defined (4-pole max)

Weighting Filter Group None
ANSI-IEC “A” weighting, per IEC 179
IEC 468 (CCIR) Qpk
Dolby 2K (CCIR-ARM)
C-message per IEEE 743-1978
CCITT per Rec O.41
“F” weighting per 15 phon loudness contour
HI-2 Harmonic weighting
User defined (8-pole max)

Bandpass & Crosstalk Functions
Tuning Range 20 Hz to 0.47×SR
Bandpass Response 10-pole, Q=19
Accuracy (at center frequency)

Analog ±0.2 dB
Digital ±0.1 dB

Residual Noise
Analog

10 Hz to 5 kHz ≤0.5 µV [–124 dBu]
5 kHz to 20 kHz ≤1.0 µV [–118 dBu]
20 kHz to 50 kHz ≤2.0 µV [–112 dBu]

Digital ≤-150 dBFS

SMPTE (DIN) IMD Function
Test Signal Compatibility Any combination of 40 Hz to 250 Hz (LF) and

2 kHz to 0.45×SR (HF), mixed in any ratio from
1:1 to 5:1 (LF:HF)

IMD Measured Amplitude modulation products of the HF tone.
Measurement bandwidth is typically 20 Hz to
750 Hz

Measurement Range 0 to 20%
Accuracy ±0.5 dB
Residual IMD8

Analog ≤0.0025% [–92 dB]
Digital ≤0.00003% [–130 dB] at 0 dBFS

≤0.0003% [–110 dB] at –25 dBFS

FFT Analyzer

Acquisition Length 800 to 256 k samples in 11 steps
Transform Length 256 to 32768 samples in binary steps
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Windows None
None-move-to-bin-center
Hann
Hamming
Blackman-Harris (4 term, –92 dB sidelobes)
Equiripple (AP design with –160 dB sidelobes)
Flat-top
Gaussian
Rife-Vincent 4-term
Rife-Vincent 5-term

Amplitude Accuracy (Flat-top window)
Analog ±0.10 dB [±1.2%]
Digital ±0.001 dB [±0.012%]

Phase Accuracy
Analog9 ±0.5 deg, 10 Hz to 5 kHz

±1 deg, 5 kHz to 20 kHz
±2 deg, 20 kHz to 50 kHz (with performance
option)

Digital ±0.05 deg, 10 Hz to 0.45×SR
Averaging

Number of averages 1 to 4096 in binary steps
Algorithm Power-based (frequency domain)

Synchronous (time domain)
Display Modes

Time Domain Normal, Interpolate, Peak, Absolute Value
Frequency Domain Displays highest FFT bin between graph points

None-Move-to-Bin-Center Window
Frequency Range ±4% of input frequency, 7th FFT bin (low limit) to

0.45×SR (high limit)
Spurious Products ≤120 dB

Residual Distortion
Analog ≤–105 dB, SR=65 kS/s

≤–90 dB, SR=262 kS/s (with performance option)
Digital ≤–180 dB

Analog Alias Rejection
Standard (High 
Resolution) A/D typically >115 dB for signals >0.554×SR
Performance
option A/D typically >85 dB for signals >0.540×SR

Multitone Audio Analyzer

Acquisition Length 512 to 32768 samples in binary steps
Transform Length 512 to 32768 samples in binary steps
Measurements Amplitude vs Frequency, Total Distortion vs

Frequency, Noise vs Frequency, Phase vs
Frequency, Crosstalk vs Frequency, and Masking
Curve

Frequency Resolution SR / Length [2.0 Hz with SR = 65.536 kS/s and
Length = 32768]
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Frequency Correction
Frequency Range ±4% of input frequency, 7th FFT bin (low limit) to

0.45×SR (high limit)
Spurious Products <–120 dB

Residual Distortion
Analog ≤–105 dB, SR=65 kS/s

≤–90 dB, SR=262 kS/s (with performance option)
Digital –140 dBFS

Analog Input Characteristics

Input Ranges 355 mVp to 200 Vp [250 mVrms to 140 Vrms] in
binary (6.02 dB) steps

Maximum Rated Input 200 Vp, 140 Vrms (dc to 20 kHz); overload
protected in all ranges

Input Impedance
Balanced Nominal 200 kΩ // 95 pF

Option 600Z adds Nominal 600 Ω 
Unbalanced Nominal 100 kΩ // 185 pF

Option 600Z adds Nominal 600 Ω 
CMRR10

355 mVp to 5.6 Vp
ranges ≥80 dB, 10 Hz to 20 kHz
11.2 Vp to 200 Vp
ranges ≥50 dB, 10 Hz to 1 kHz

Input Related Crosstalk ≤(–100 dB + 3 µV) at 20 kHz

Digital Input Characteristics

Formats
Balanced (XLR) AES3 per AES3-1997
Unbalanced (BNC) SPDIF-EIAJ per IEC 60958
Optical (Toslink®) per IEC 60958-3

Sample Rates 28.8 kHz to 108 kHz per connector 
Word Width 8 to 24 bits
Input impedance

Balanced (XLR) Nominally 110 Ω or >2.5 kΩ
Unbalanced (BNC) Nominally 75 Ω or >3 kΩ

Digital Interface Measurements

Input Sample Rate
Internal Reference ±0.0003% [±3 PPM]
External Reference ±0.0001% [±1 PPM]

Input Voltage
Balanced (XLR) 200 mV to 5.10 Vpp, ±(10% + 50 mV)
Unbalanced (BNC) 100 mV to 1.275 Vpp, ±(10% + 12 mV)
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Jitter Amplitude (peak calibrated)
50 kHz–100 kHz BW 0 to 3.00 UI, ±(10% + 2 ns) 
other BW selections 0 to 1.00 UI, ±(10% + 2 ns)

Jitter Flatness11 ±1 dB, 100 Hz to 20 kHz
Residual Jitter12 ≤2 ns [0.012 UI at 48 kS/s, 0.024 UI at 96 kS/s]
Jitter Spectrum Spurious products are typically <0.003 UI

[–50 dBUI] or 30 dB below jitter signal, whichever
is larger

Channel Status Bits Full implementation per IEC 60958, English
language decoded, common to both channels

Formats Professional or consumer, or Direct Hex source
User Bits Not displayed
Validity Flag Displayed for each channel
Parity Displayed for total signal (both channels

combined)
Signal Confidence Displayed for total signal (both channels

combined)
Receiver Lock Displayed for total signal (both channels

combined)
Coding Error Displayed for total signal (both channels

combined)

Sync/Reference Input Characteristics

Signal Compatibility
AES3 AES3id 1995, SPDIF (IEC 60958); 28.8–100 kHz
Video NTSC, PAL, or SECAM
Squarewave 8.0 kHz to 10.0 MHz

Minimum Input Amplitude 200 mVpp
Input Impedance Nominally 75 Ω or >5 kΩ

Lock Range ±0.0015% [±15 PPM]

Auxiliary Signals

Monitor Outputs
Signals Replicas of both analyzer inputs plus two

additional signals depending on the
measurement mode. Not guaranteed to operate
with sample rates above 108 kS/s.

Typical Amplitude 0 to 4 Vpp (Rs = 422 Ω)
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System specification including contributions from both analyzer and generator. Valid at
32.0, 44.1, 48.0, 65.536, 88.2, and 96.0 kS/s only. Flatness may degrade at other
sample rates.

12
System specification valid only if (1) the jitter generator amplitude is turned off; (2) the
digital input is ≥ 1.0 Vpp (XLR) or ≥ 250 mVpp (BNC); and (3) the analyzer is set for
700 Hz–100 kHz bandwidth.



Auxiliary Control I/O
Inputs (8 bits) 5 V TTL-compatible CMOS

Absolute maximum range –0.5 V to 5.5 V
Float State 20 kΩ pull-up to +5 V

Outputs (8 bits) 5 V TTL-compatible CMOS
Voltage Range 0 to 5 V

Trigger Input
Absolute Maximum Range –0.5 V to 30 V
Minimum High Voltage 1.25 V
Maximum Low Voltage 0.5 V
Input Impedance >50 kΩ

Contact resistance 
(for short control) 5 kΩ maximum

Trigger Output
Voltage Range 0–5 V nominal
Output Impedance 150 Ω nominal
Source Analog Generator

Digital Generator
Jitter Generator
External Trigger Input
Line (Mains)
Channel A Receive Sub-Frame
Channel B Receive Sub-Frame
Channel A Receive Sub-Frame De-jittered
Channel B Receive Sub-Frame De-jittered
Receive Block
Receive Error
Channel A Transmit Sub-Frame
Channel B Transmit Sub-Frame
Channel A Transmit Sub-Frame De-jittered
Channel B Transmit Sub-Frame De-jittered
Transmit Block
Channel A Sync/Ref Receive Sub-Frame
Channel B Sync/Ref Receive Sub-Frame
Sync/Ref Receive Block
Sync/Ref Receive Error

General/Environmental

Power Requirements 100/120/230/240 Vac (–10% +6%), 50–60 Hz,
75 VA max 

Temperature Range
Operating +5°C to +45°C
Storage –40°C to +75°C

Humidity 90% RH to +40°C (non-condensing)
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Max Operating Altitude 3000 m
EMC13 Complies with 89/336/EEC, CISPR 22 (class B),

and FCC 15 subpart J (class B)
Dimensions

Width 16.8 inches [42.7 cm]
Height 3.0 inches [7.6 cm]
Depth 14.2 inches [36.1 cm]

Weight Approximately 16.2 lbs [7.4 kg] unpacked, all
hardware options installed.

Safety Complies with:
 73/23/EEC, 93/68/EEC, and EN61010-1 (1990)
+ Amendment 1 (1992) + Amendment 2 (1995).
Installation Category II, Pollution Degree 2

CAN/CSA-C22.2 No 1010.1-92, Safety
Requirements for Electrical Equipment for
Measurement, Control, and Laboratory Use,
Part 1: General Requirements (Includes
Amendment 1)

CAN/CSA-C22.2 No 1010.1B-97, Amendment 2
to CAN/CSA-C22.2 No 1010.1-92, “Safety
Requirements for Electrical Equipment for
Measurement, Control, and Laboratory Use,
Part 1: General Requirements”

UL Std No 3111-1, Equipment for Measurement
Use; Part I: General Requirements
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Emission and immunity levels are influenced by the shielding performance of the
connecting cables. EMC compliance was demonstrated using Audio Precision part
numbers CAB-XMF and CAB-AES2.
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Chapter 7
GPIB Configuration

Introduction

As an op tion, ATS-2 can be or dered in its GPIB con fig u ra tion, model
ATS2G. GPIB ca pa bil i ties can also be added to ATS-2 af ter pur chase with
the in stal la tion of a GPIB up grade at the Au dio Pre ci sion fac tory or at a
fac tory-au tho rized representative.

The GPIB con fig u ra tion brings the IEEE-488.2 in ter face stan dard, also
known as the Gen eral Pur pose In ter face Bus or GPIB, to ATS-2. Hard ware 
for GPIB con sists of a cir cuit board mounted on a con nec tor panel as sem -
bly that is fit ted in the re served space on the ATS-2 rear panel, as shown
below. 

APIB or GPIB?

ATS-2 is nor mally con trolled by Au dio Pre ci sion’s ATS mea sure ment
soft ware us ing the APIB in ter face bus. In the GPIB con fig u ra tion, ATS-2
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can be con trolled by ei ther GPIB or APIB as se lected by a switch on the
GPIB hard ware mounted on the ATS-2 rear panel.

The GPIB con fig u ra tion makes it pos si ble to in te grate ATS-2 hard ware
into a sys tem that may in clude other GPIB-com pat i ble in stru ments and de -
vices un der op er ated by your choice of GPIB control software.

Au dio Pre ci sion does not pro vide con trol soft ware for GPIB ap pli ca -
tions. We do of fer full doc u men ta tion of the ATS-2 func tions con trol la ble
by GPIB in the ATS-2 GPIB Pro gram mer’s Ref er ence Man ual, which con -
tains a list ing of all ATS-2 GPIB com mands and de tailed ex pla na tions of
com mand pa ram e ters. The ref er ence man ual co mes with a com pan ion
CD-ROM that con tains sam ple pro grams writ ten for Microsoft Vi sual Ba sic. 
These pro grams pro vide ex am ples of how to con trol ATS-2 to perform
many common audio measurements.

With this in for ma tion and some knowl edge of ATS-2 the ory and op er a -
tion, you can de velop cus tom soft ware to con trol your GPIB sys tem. A rec -
om mended path of soft ware de vel op ment is dis cussed in the following
topics.

The GPIB Software Development Process

A prac ti cal work ing knowl edge of ATS-2 is re quired in or der to de velop
ef fec tive GPIB soft ware for it. Fig ure 23 il lus trates a typ i cal soft ware de vel -
op ment sce nario in which the Au dio Pre ci sion ATS mea sure ment soft ware
is used to de velop ex per tise with the ATS-2 be fore at tempt ing to in te grate
the in stru ment into a larger sys tem con trolled by a GPIB interface software 
program.

Since the GPIB pro gram ming com mands for ATS-2 are mod eled di -
rectly on the ATS user in ter face, the fast est path for GPIB soft ware de vel -
op ment in volves the use of the ATS mea sure ment soft ware as a learning
tool.

Work ing in ATS you can de velop test meth ods for your DUT and build
con fi dence that your meth ods are cor rect. You can use AP Ba sic and the
Learn Mode but ton on the tool bar to de velop AP Ba sic mac ros that per -
form the tests you wish to de velop for GPIB. As you learn how ATS-2 best
op er ates un der ATS con trol, the tasks in volved in de vel op ing equiv a lent
code for the GPIB port will be greatly simplified.
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While de vel op ing tests in ATS, re fer to the ATS-2 GPIB Pro gram mer’s
Ref er ence Man ual for the equiv a lent GPIB com mands. It con tains de tailed
in for ma tion on ev ery GPIB com mand for ATS-2, along with gen eral pro -
gram ming in for ma tion, code ex am ples and ref er ence ma te rial. It is avail -
able sep a rately from Au dio Pre ci sion.

In cluded with the ATS-2 GPIB Pro gram mer’s Ref er ence Man ual is a
CD-ROM con tain ing GPIB sam ple files.

The com mand de scrip tion sec tions of the Pro gram mer’s Ref er ence Man -
ual show ATS soft ware con trol pan els for each of the ma jor sub sec tions of
ATS-2. Each panel is il lus trated with GPIB com mand call-outs to help you
con vert your ATS soft ware setup to GPIB com mands. Fig ure 24 il lus trates
this for the ATS-2 An a log Generator panel.

The GPIB Software Development Process Chapter 7: GPIB Configuration
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Using both GPIB and APIB for Software Development

Your ATS-2 al ready has an APIB port on the rear panel. The GPIB op -
tion adds a GPIB port and con fig u ra tion switches and in di ca tors. The rear
panel switches pro vide a means to se lect which port is to be used to con -
trol ATS-2 and to as sign the in stru ment’s GPIB ad dress. Dur ing the soft -
ware de vel op ment pro cess you may switch be tween the two modes in
or der to take ad van tage of the in ter ac tive de vel op ment en vi ron ment of the 
ATS measurement software.

The two ports can not con trol ATS-2 si mul ta neously. You must se lect
GPIB or APIB as the con trol port.

To use GPIB to con trol ATS-2, con nect an ap pro pri ate ca ble from the
GPIB in ter face card on the con trol ling com puter to the port on ATS-2, and 
se lect GPIB on the rear-panel switch as shown in Fig ure 25 (left-most
switch clicked down to “0”). An LED will light to in di cate that GPIB is
selected.

When the GPIB port is in con trol, the APIB port on ATS-2 must be dis -
con nected from the APIB in ter face card in the com puter.
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Figure 24. ATS-2 Audio Analyzer panel with GPIB command call-outs.



To use APIB to con trol ATS-2, se lect APIB on the rear-panel switch as
shown in Fig ure 26 (left-most switch clicked up to “1”), and con nect a ca -
ble from the APIB in ter face card on the con trol ling com puter to the port
on ATS-2.

Whether con trolled by APIB or GPIB, ATS-2 still uses APIB to con trol
other Au dio Pre ci sion APIB in stru ments and ac ces so ries such as the
DCX-127 and the SWR-2122 fam ily of switch ers. Fig ure 27 il lus trates how
to con nect these de vices to the ATS-2 when the GPIB port is the con trol
port; Fig ure 28 il lus trates how to con nect an APIB con trol ler to this sys tem
when the GPIB port is disabled. 

Establishing GPIB Communication

GPIB Connection

The ATS-2 with Op tion GPIB in stalled has a 24-pin GPIB-com pat i ble
con nec tor on the rear panel. This D-shell con nec tor con forms to the me -
chan i cal re quire ments of IEEE-488.1-1987. The in stru ment is con nected to 
the in stru ment con trol ler via an ap pro pri ate ca ble. The in stru ment con trol -
ler (a com puter) must have a cor re spond ing GPIB in ter face port. Stan dard 
GPIB ca bles are de signed so they can be stacked if needed to con nect
mul ti ple instruments into your GPIB system.
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When con nect ing in stru ments into a GPIB sys tem, ob serve the fol low ing 
rules:

§ Connect and disconnect instruments from the bus only when the
power to all instruments in the system is off.

§ Assign a unique GPIB address to each instrument (device) on the
bus.

Chapter 7: GPIB Configuration The GPIB Software Development Process

64 Getting Started with ATS-2

Figure 27. APIB connections to ATS-2 with GPIB option in GPIB control mode. SWR-2122 

Switcher and DCX-127 connected to the APIB connector of the ATS-2. The  computer

APIB cable is not connected.

Figure 28. APIB controller connections, ATS-2 with GPIB option in APIB control mode.

Computer APIB cable connected to DCX-127, then to SWR-2122, then to ATS-2.



§ Devices may be connected in a star or linear configuration (see
Figure 29), or a combination of star and linear configurations.

§ Do not attach more than 15 devices (including the controlling
computer) to one bus.

§ Cable length between devices must not exceed 2 meters (6 feet).

§ One device must be attached to the bus for every two meters (6 feet)
of cable.

§ Total cable length must not exceed 20 meters (66 feet).

§ At least two-thirds of the devices on the bus must be powered up for
proper system operation.

ATS-2 GPIB Address and I/O Mode Switch

Like all in stru ments on the bus, ATS-2 must be set to a unique GPIB ad -
dress.

An ad dress se lect switch bank with six slide switches sets the GPIB ad -
dress and the I/O Mode. The switch is shown be low in Fig ure 30. The five
switches to the right of the bank set the 5-bit bi nary pri mary ad dress of the
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Avoiding accidental EEPROM failure

Your ATS-2 stores system information and calibration constants in a 
non-volatile EEPROM memory circuit with the instrument.

It is possible to accidentally change or erase the data stored in the
EEPROM memory. The loss of this data could cause your instrument to 
perform out of specification, behave erratically or even fail entirely.
Accidental EEPROM erasure is rare, but it can be caused by
simultaneous use of both the APIB and GPIB buses, which can occur
when you are changing operation from one control bus to the other.

To prevent EEPROM erasure when switching control buses, you
should always follow these orders of operation:

APIB to GPIB changeover:

1. Exit the ATS-2 control software (ATS), then disconnect the APIB
cable.

2. Select GPIB operation using the rear panel switch and proceed
with GPIB operation. 

GPIB to APIB changeover:

1. Select APIB operation using the external switch on the ATS-2
rear panel.

2. Connect the APIB cable, launch the ATS-2 control software
(ATS) and proceed with APIB operation.

The GPIB cable can safely remain connected during APIB
operation.



in stru ment. Le gal ad dresses are 0 through 30. Set each switch up for a bi -
nary 1 or down for a binary 0.

The left-most switch in the bank sets the con trol mode, in de pend ent of
the GPIB ad dress switch set tings. Click the switch to 0 (down) to set the
con trol mode to GPIB.

The APIB port must not be connected to an active Audio

Precision APIB interface card when the GPIB mode is

selected.

Set the switch to 1 (up) to set the con trol mode to APIB. The APIB
mode dis ables the GPIB in ter face (the pins are all set to the high-im ped -
ance state) and en ables APIB to con trol the ATS-2.
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Figure 29. GPIB devices may be connected in star, linear,

or combination star/linear configurations.



GPIB Status LEDs

The six GPIB Sta tus LEDs shown in Fig ure 30 in di cate the cur rent sta tus 
of the GPIB bus. When an LED is il lu mi nated, the sta tus in di cated is as
follows:

§ SRQ (SRQ interrupt)
The instrument has asserted the SRQ line in order to request service
from the GPIB controller.

§ GPIB
The instrument is under the control of the GPIB interface, set by the
control mode switch. The APIB connector will be driven internally by 
the instrument GPIB interface board.

§ TA (Talk Addressed)
The instrument is talk addressed by the GPIB controller.

§ LA (Listen Addressed)
The instrument is listen addressed by the GPIB controller.

§ MAV
The instrument has one or more bytes in the output queue and has
asserted the MAV (Message AVailable) bit in the Status Byte Register.

§ ERR
The instrument has detected an error condition that has not been
reported to the system controller. This LED goes off when the error
condition has been reported in response to the :ERRM? or :ERRS?
error queries.

GPIB Program Message Terminators

When the in stru ment is ad dressed as a lis tener, two pro gram mes sage
ter mi na tors (PMT) are sup ported:
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§ EOI line asserted with the NL character (ASCII 10, the linefeed
character);

§ EOI line asserted with the last byte of a message.

The NL character alone without EOI is not supported.

When the in stru ment is ad dressed as a talker, one PMT is sup ported:

§ EOI line asserted with the NL character (ASCII 10, the linefeed
character).
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